
WnBrowse Topic Index
The Index lists Help topics available for WnBrowse.

To learn how to use Help, press F1 or choose Using Help from the Help menu.
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    File Menu Commands

Open

Opens a new file.

When you select the Open command you are presented with the Open File dialog 
box. From there you can select the file that you want to browse. If the selected file is 
a text file, then the    initial viewing mode will be text, otherwise the hex viewing 
mode will be selected.

Related Topics
      View Mode
      File Types

Save As...

Displays a Save As dialog box from where a file can be selected for saving the 
currently selected text. This option is greyed when no text is selected.

Close File

Closes the current file, releases any storage and iconizes WnBrowse.

Launch Current File

Launches the current file, with it's associated application, or with the default text 
editor. If the file being viewed is a Windows 16 bit program, it is executed.

Previous File

Displays    the previous file from the current directory that matches the file 
specification used for the last Open request.

Next File

Displays the next file from the current directory that matches the file specification 
used for the last Open request.

Print...

The Print option can be used to print the entire file, or a selected portion of a file on 
the currently active printer. A dialog box is displayed allowing various options to be 
selected.

Related Topics
      Selecting Text
      Print Options

Printer Setup

Allows you to set printer options for WnBrowse. The options available depend upon 
the selected printer type.



Show Information...

Displays a dialog box containing information about the currently selected file, 
including the file size, modification date and version information

Exit

Exits WnBrowse



Edit Menu Commands

Copy

Copies any selected text to the Windows Clipboard.

Select All

Quickly selects the entire contents of a file. 

Selected text can be copied to the Windows clipboard, printed, or saved to a file.



Search Menu Commands

Find

Displays the find dialog box from where you can search for a character string within 
the file being browsed. The following options can be selected :

Find What 
Enter the string to be searched for. This can be entered in ASCII or hexadecimal

Direction -
Specifies the direction of the search, backwards or forwards.

Origin -
Specifies from where the search comences. Entire Scope searches from the top or 
bottom of the file. Current position searches from the top or bottom of the current 
window.

Options -
Match Upper/Lower case - string comparison is case sensitive
Scroll to Top - Matching lines are scrolled to the top of the window

Repeat Last Find

Following a successful find, finds the next occurance of the same string within the 
file.

Goto

Displays a dialog box from which you can select the new file location.

In text view mode, enter the line number.
In Hex view mode, enter the hexadecimal offset.



View Menu Commands

Text Mode

The selected file is displayed in text mode.

Hex Mode

The selected file is displayed in hex mode.

View ZIP File Contents

Displays information about the contents of a ZIP file.

Redisplay Zip File

Redisplays the Zip file containing the Zipped file being viewed.

Related Topics
      View Mode
      Viewing Zip Files



Options Menu Commands

Select Font

Selects the font to be used for displaying and printing the selected file.

Related Topics
      Font Selection

Preferences...

This item displays a dialog box from where you may specify your preferences for 
many    of the WnBrowse    options.

Colours

Displays a dialog box that allows the colours of certain WnBrowse elements to be 
selected.

Set Line Length

Sets the    display length for lines of non-text files using the text viewing mode.

Save Settings

Saves the currently active options, (Font, Ruler, tabs, scroll bars and Colours), so that 
they    are automatically used every time WnBrowse is started.

Related Topics:

Setting Preferences



Setting Preferences

The Preferences menu item on the Options menu displays a dialog box from where many 
WnBrowse options can be set.

Translation Options

When the EBCDIC to ASCII option is selected, any EBCDIC characters are converted 
to ASCII before being browsed or printed. This option is useful when browsing or 
printing a file downloaded from an IBM mainframe computer.

The OEM to ANSI option can be used to translate OEM characters (such as box 
drawing characters) to their ANSI equivalents. This option should be set off when 
browsing files containing special national language characters.

Display Options

When the Ruler option is set, a ruler will be displayed at the top of the output 
window while in text view mode.

When the Scroll Bars option is set, scroll bars are displayed if the file length or width
exceeds the output window size. If this option is not set, scroll bars will not be 
displayed.

The Status Line option, when set, causes a Status line to be displayed at the bottom
of the output window.

The Button Bar option, when set, results in the display of a button bar at the top of 
the output window.

Tab Processing

The Expand Tabs option controls whether embedded tab characters within the file 
being viewed, will be expanded when the file is viewed or printed.

The Tab Size value specifies the number of characters between each tab stop. This 
value must be between 2 and 16.

Launch Options

The Default Editor input box contains the name of the editor that is to be used to 
edit text files when the Launch option is used.    If the name is blank, then editing will 
not be allowed.

When the Minimize on Launch option is set, WnBrowse will minimize after a file is 
launched via the Launch button, or Launch command.

Any changes that you make using the Preferences dialog effect the current execution of 
WnBrowse only. If you wish to save the settings for all future executions, you should select 
'Save Settings' from the Options menu.



File Information Dialog

The file information dialog can be requested by selecting 'Show Information...' from the 
File menu, or by clicking on the information button in the Button Bar. 

Depending on the type of file being viewed, some or all of the following information will be 
displayed :

File Name

The full path name of the file that is being browsed. Long path names will be 
truncated to fit in the dialog box by replacing some directory levels with ellipses ('...').

Type

The type of file being browsed. WnBrowse primarily classifies files as text or non-text.
Some types of non-text files are further classified as specific types if possible. This 
includes Zip files and program executables. If the file being browsed is a member of a
Zip file, this will also be indicated.

Size

The size of the file being browsed is displayed in bytes and in megabytes.

No. of Lines

For text files only, the number of lines in the file is displayed.

Last Modified

The date and time that the file was last modified is displayed.

Program Version Information

If the file being browsed is a Windows 16 bit executable (EXE,DLL etc), WnBrowse will check 
to see if it contains version information. If such information is present, the File Information 
dialog is expanded to display the following information:

Version

The version of the file being browsed. For example, 3.10 is displayed when browsing 
the Windows 3.1 version of WRITE. The exact format of the version information will 
vary and is dependant on the programs authors requirements.

Company

The name of the Company that produced the file being browsed.

File Description

A description of the file being browsed. The level of detail provided by this 
information is again dependant on the programs author, but should be useful in 
recognizing what the file is used for, or what application it belongs to. If version 
information is not available for the file being browsed, WnBrowse will check to see if a



program description has been included in the executable. If it has, it will be displayed
here.

The program version information can be useful in determining what a file is used for, and 
can assist in tracking down and deleting remnants of discarded products. It can also be 
interesting    to know what some of those strangely named DLL's are actually used for.

Imported DLL List

If a 16 bit Windows EXE or DLL file (or an OS/2 1.x executable) is being browsed,    a list of 
DLL's that are imported can be displayed by selecting the More... button. This information 
can be useful in determining what application a DLL file belongs to. You should be aware 
however that a DLL might be used by an application even if it is not on the list of imported 
DLL's.

Related Topics:
File Types



View Modes
WnBrowse can display files in two ways or modes. The initial view mode is selected 
automatically according to the file type,    but can be changed from the view menu.

Text Mode

The file is displayed line by line. Scroll bars are provided if necessary for both vertical 
and horizontal scrolling. 

If the file is a non-text    file, then the file is displayed with 75 characters per line. This 
can be changed by selecting 'Set Line Length' from the Options menu.

Related Topic
      File Types

Hex Mode

Each display line is separated into three parts.
 
1. The offset into the file of the line in hex.
2. 16 bytes of the file displayed in hexadecimal.
3. the ASCII or EBCDIC translation.

When hex mode is selected, WnBrowse will switch to a fixed font if necessary.

Related topics
      View Menu Commands



File Types
When WnBrowse opens a selected file, it classifies the file into one of three types. 

Text File

A text file consists of one or more lines of text, each containing 256 characters    or 
less, separated by    ASCII NL/CR characters. Text files are presented initially using the
text viewing mode.

Note: The 256 character per line limit can be changed to any value between 80 and 
1024 by adding    the following parameter to WNBROWSE.INI

MaxLineLen=nnn

Non-Text File

Any file that does not meet the criteria for a text file, is considered to be a non text 
file. All such files are presented initially using the hex viewing mode.

While it makes no sense to display some non text files in the text viewing mode, for 
example EXE files. some files that WnBrowse classifies as non text , contain large 
amounts of text, best read using the text viewing mode. Such files include word 
processing files.

ZIP Files

All non-text files are checked to see if they are ZIP files. Such files are processed by 
WnBrowse as for non-text files, except that their contents can be listed from the 
View menu.

File Information

The File Information menu option (or the information Button) can be used 
to display information about the file being browsed. Displayed along with 
other file details is the file type. For non-text files, WnBrowse will attempt to 
identify what type of file is being displayed. Currently WnBrowse will 
recognize Windows, Windows NT and OS/2 executables. For Windows 16 bit 
files, WnBrowse will    display the file description and version (if available).

Related topics
      View Mode
      Viewing Zip Files
      File Information Dialog



Keyboard Usage

F1 - Displays the Help Index
F3 - Performs a Find Next
ESC - Closes the file and iconizes

ctrl-T - Selects text view mode
ctrl-H - Selects hex view mode

ctrl-M - Toggles the display of the menu
ctrl--S                - Saves the currently selected options

ctrl-C - Copies selected text to the clipboard

ctrl-Page Up - Browses the previous file
ctrl-Page Down                              - Browses the next file

Page Up - Scrolls up one window full
Page Down - Scrolls down one window full
Up Arrow - Scrolls up one line
Down Arrow - Scrolls down one line
Left Arrow - Scrolls left 8 characters
Right Arrow - Scrolls right 8 characters
Home - Scrolls to the top of the file
End - Scrolls to the bottom of the file.



 Font Selection
WnBrowse supports fonts for both displaying and printing the selected file.    Fonts are 
selected by using the Select Font command from the options menu. The number of fonts 
available will vary according to the currently selected printer.

Sometimes WnBrowse will select a new font automatically. For example if you switch from 
text view mode to hex view mode WnBrowse will ensure that a fixed font is being used. 
When you switch back to text view mode, the original font will be restored.

Related Topics
      Options Menu 
      View Mode



Selecting Text
You can use a mouse to select text from the file being browsed. The selected text is 
displayed in a different colour to distinguish it from the unselected text. You can copy 
selected text to the clipboard, print it on an attached printer, or save it to a file.

Select text using the following procedure.

1. Move the cursor to the first or last character you wish to select.

2. Press and hold the left mouse button. The cursor will change.

3. Drag the mouse, up or down , left or right, until you have selected the required text.

4. Release the mouse button.

If you move the mouse above or below the WnBrowse window, the text will be scrolled while 
being selected.

Selection Hint :
If you want to select a large portion of the file, click and hold the mouse before the 
first character required, then press the Page-Down key to select text a page at a 
time.



Viewing ZIP Files

WnBrowse allows you to browse the files contained within a ZIP file without having to unzip 
the entire file first. When WnBrowse opens a file, it checks to see if it is a normal ZIP file or a 
self extracting ZIP file. If it is, the View menu option 'View ZIP file contents' and the ZIP 
button are activated. Selecting either of these will display a scrollable list of the files 
contained within the ZIP file. Also displayed is the total size of the ZIP files and the level of 
PKUNZIP needed to unzip them.

If a file in the list is double-clicked, or if    a file is selected and the View button pressed, 
WnBrowse will unzip the selected file and display it. After the viewing of the file is 
completed, WnBrowse will delete the
unzipped file.

When a zipped file is being displayed you can redisplay the original ZIP file by pressing the 
redisplay ZIP file button on the button bar or by selecting Redisplay Zip file from the View 
menu

WnBrowse uses the PKUNZIP program to unzip any selected file. Therefore, you must have 
a copy of PKUNZIP.EXE on your system. The level of PKUNZIP must also match or better 
the level required to unzip the selected file.

When you browse a zipped file, WnBrowse creates a temporary file, and deletes it after 
browsing is complete. By default, the temporary file is placed in the directory defined by the 
TEMP environment variable, or in the root directory    of the disk containing Windows, if 
there is no TEMP variable.

NOTE To avoid the possibility of inadvertently overwriting a file in your root directory, it is 
strongly recommended that you define a temporary directory.



Print Options

The print dialog box can be used to select a number of print options. You can print the entire 
file or the currently selected portion. The left, top and bottom margin sizes can be specified 
and you can define headers and footers to be printed on each page. You can request that 
the file be printed using the default printer font, and not the currently selecting viewing font.
You can also request that embedded form feed characters within the file (hex '0C') are to be 
honored.

Note : When you select the process Form Feed option, you should make sure that the 
current page size is large enough to accommodate the resulting pages.

The default left margin is one inch (or 2.5 cm) and the default top and bottom margin sizes 
are one half inch (or 1.25cm),. The unit used, inches or centimeters,    is selected according 
to the measurement option set using the control panel.

If you select the Print Headers/Footers box, the dialog box is expanded to include two 
extra edit boxes, one for the header text and one for the footer text. You may use the default
values, or select your own. Along with the text in the header and footer string, you can 
include the following special codes:

&d - Inserts the current date
&t - Inserts the current Time
&p - inserts the current page number
&f - inserts the file name

Along with the special codes, you can use the '/' character to left justify, right justify and 
centre the text contained in the headers and footers. For example :

            left/centre/right

Will print 'left' left justified, 'right' right justified and 'centre' in the centre of the page. 

            //Page &p

Prints 'Page n' right justified .



Command Line Options

The command line can be used to pass the name of the files to be browsed and/or 
parameters defining WnBrowse options. A parameter is distinguished from a file name by 
preceding it with a dash (-).

WnBrowse currently supports three parameters. One specifies the initial position and size of 
the WnBrowse window, one allows a    set of saved options (including the window size and 
position) to be used, and the third supports drag and drop printing.

Specifying the Window Size and Position

The window size and position is    given as four values, respectively the position of the
upper left hand corner of the window, and the width and height of the window. All 
values are given in    pixels.

                                            -100 150 300 400

This    results in a window    with a top left hand corner positions at X and Y (100,150) 
with a width of 300 pixels and a height of 400 pixels.

Using Saved Options.

WnBrowse allows you to save a number of different options in the wnbrowse.ini file. 
Each set of options can be given a name, the default being 'WnBrowse'. To use    (or 
save) a set of options with a different name, you must tell WnBrowse what name to 
use with a command line parameter :

                        -Iname

Where 'name' is the name of the options you wish to use (or save).

Drag and Drop Printing.

Windows 3.1 drag and drop printing is supported by WnBrowse via a new parameter 
(-P). When this parameter is specified on the command line, the file will be printed 
and WnBrowse will then close. To use this facility, you must register WnBrowse as the
printing program using the Windows 3.1 REGEDIT program. 



Button Bar
The WnBrowse button bar allows you to perform many operations with a single click of a 
mouse button. The following buttons are available.

Displays the file open dialog box.

Browse the previous file.

Browse the next file.

Print the current file.

Display information about the current file.

Copy selected text to the Windows clipboard.

Search the file for a character string

Repeat the previous search.

Display the file in the text view mode.

Display the file in the hex view mode.

Display the files contained within a ZIP file.

Select a font.

Set your colour preferences.

Display the WnBrowse help.

Launch the file with it's associated application.



Redisplay the previous ZIP file

Close the current file and Iconize

If a button is not currently active then it will be greyed and will not go down when it is 
clicked. For example, the clipboard button is disabled when there is no selected text, and the
launch button is disabled when the file has no associated application.

The function of a button can be displayed in the status line by clicking the right mouse 
button over the button bar.



Registering WnBrowse

WnBrowse is a shareware product. This means that you can use    WnBrowse for a reasonable
amount of time without charge for evaluation purposes. If you decide to keep WnBrowse, 
you must register your copy by sending payment to the author. You can also pass on 
WnBrowse to friends and colleagues so that they may also evaluate the product. 

You can also register WnBrowse using the CompuServe shareware registration process. 
Simply go to the SWREG service (GO SWREG) and follow the online prompts. For details refer
to WNBROWSE.TXT.

When you register WnBrowse you will receive many benefits :

1. You will have access to free product support.

2. You will receive advanced details of new versions of this and other products.

3. You will be able to request changes to WnBrowse to help me make it a better tool.

4. You will allow me to continue to support this and other tools in the future.

For further details please refer to the file WNBROWSE.TXT .



Author

Nigel G Thomas. I can be contacted at 39 Redshank Avenue, Winsford, Cheshire CW7 1SP, 
England or on CompuServe (ID 100117,1542). I would love to hear your comments and 
suggestions.



ZIP File

A file format that enables one or more files to be contained in a compressed format in a 
single file, commonly used to ship files on disk or via a communications link. The format and 
supporting programs (PKZIP and PKUNZIP)    are copyright PKWARE Inc.




